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Sonos app for Mac or PC
• Lets you control all your music and rooms from any desktop or laptop computer in your house. 
• Simply install the software and follow the prompts to guide you through setup and music sharing. You 

can download the software at www.sonos.com/support. 

Already have Sonos?

If you are adding the Sonos app for Mac or PC to an existing Sonos system, please see Adding the Sonos 
app for Mac or PC for more information.

New to Sonos?

It takes just a few steps to get Sonos up and running. Unpack the Sonos products you purchased and refer to 
the Quickstart Guide included in the box. Once you’ve set up Sonos, you can easily download and install the 
Sonos app for Mac or PC. The Sonos app for Mac is compatible with Macintosh® OS X® 10.9 and higher. 
The Sonos app for PC is compatible with Windows® 7 and higher.

For additional help, please visit our website at www.sonos.com/support/guides to view the latest product 
documentation.

Note: The Sonos app for Mac or PC requires that you have an Mac or PC, one or 
more Sonos players, and a wireless router set up in your home. Macs, PCs, and 
Sonos products are sold separately.
Chapter 1

http://www.sonos.com/support/guides
http://www.sonos.com/support
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Your Home Network
To access Internet music services, Internet radio, and any digital music stored on your computer or Network-
Attached Storage (NAS) device, your home network must meet the following requirements:

Home network requirements

• High-speed DSL/Cable modem, or fiber-to-the-home broadband connection for proper playback of 
Internet-based music services. (If your Internet service provider only offers Satellite Internet access, you 
may experience playback issues due to fluctuating download rates.)

• If your modem is not a modem/router combination and you want to take advantage of Sonos' automatic 
online updates, or stream music from an Internet-based music service, you must install a router in your 
home network. If you do not have a router, purchase and install one before proceeding. If you are going 
to use the Sonos app on an Android™ or iOS device, or you are setting up Sonos wirelessly, you will need 
a wireless router. 

Note: Your network must have a high-speed Internet connection, as Sonos is 
designed to provide you with free, online software updates. Sonos must be 
registered to receive these updates so be sure to register during the setup 
process. We do not share your e-mail address with other companies.

Note: Sonos communicates over a 2.4GHz home network supporting 802.11 
b/g/n wireless technology. 5GHz networks are not supported in a completely 
wireless Sonos setup.
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• Connect a Sonos BRIDGE, BOOST™ or player to your router if: 
• You have a larger home where the WiFi performance isn’t reliable and you want to strengthen the 

wireless performance of Sonos.

• Your WiFi network is already in high demand with streaming video and web surfing and you want to 
create a separate wireless network exclusively for your Sonos speakers.

• Your home network is 5GHz only (not switchable to 2.4GHz).

• For best results, you should connect the computer or NAS drive that contains your personal music library 
collection to your home network router using an Ethernet cable. 

System requirements
• 500 MHz processor or better 
• 128 MB RAM minimum/256 MB RAM recommended 
• Network hardware as described above

Compatible operating systems
• Windows 7 and higher
• Macintosh® OS X 10.9 and higher 

Compatible music services
Sonos works seamlessly with most music services, including Apple Music™, Deezer, Google Play Music, 
Pandora, Spotify and Radio by TuneIn, as well as downloads from any service offering DRM-free tracks. 
Service availability varies by region. 

For a complete list, see www.sonos.com/music. 

Compatible playlist formats
• iTunes®
• Napster®
• Windows Media Player® 
• WinAmp®

Compatible audio formats
• MP3
• AAC (without DRM)
• WMA without DRM (including purchased Windows Media downloads)
• AAC (MPEG4)
• AAC+
• Ogg Vorbis
• Apple Lossless
• Flac (lossless) 
• Uncompressed WAV and AIFF files
• Native support for 44.1kHz sample rates. Additional support for 48kHz, 32kHz, 24kHz, 22kHz, 16kHz, 

11kHz, and 8kHz sample rates. MP3 supports all rates except 11kHz and 8kHz.

http://www.sonos.com/music
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Previously purchased Apple “Fairplay” DRM-protected songs may need to be upgraded. See Apple for 
details. WMA Lossless formats not currently supported.

Compatible streaming formats
• MP3
• WMA
• HLS/AAC

Compatible screen reader software
• JAWS® for Windows® screen reading software

Getting Started
Adding the Sonos app for Mac or PC
Download the Sonos app to a Mac or PC that’s connected to your wireless network (Sonos app use requires 
you have at least one Sonos player set up in your home). The Sonos app for Mac is compatible with 
Macintosh® OS X® 10.9 and higher. The Sonos app for PC is compatible with Windows® 7 and higher.

For information on when to use a wireless router with Sonos, please visit our website at 
http://faq.sonos.com/apps.

1. Go to www.sonos.com/install to download the free Sonos app for Mac or Sonos app for PC.

2. Double-click the Sonos  icon and follow the prompts to add the Sonos app to your Sonos system. 
During setup you will be prompted to press the button(s) on one of your Sonos products:
• Sonos BRIDGE. Press the Join button on top. 
• Sonos BOOST or SUB. Press the Join button on the side. 
• Sonos Players. Press the Play/Pause and Volume Up buttons simultaneously (releasing as soon as the 

status indicator starts to blink.) 
If you need assistance, please go to our website at www.sonos.com/support. 

Adding a household
Your Sonos app for Mac or PC gives you quick and easy access to all of your Sonos systems. Simply add a 
household to your Sonos app and it will automatically connect as you move from one place to another. So, 

Note: For the latest system requirements, including supported operating system 
versions, please visit our website at http://faq.sonos.com/specs.

Note: To use the Sonos app, your Mac or PC, must be connected to your wireless 
network and the Wi-Fi setting must be turned on.

Note: During installation, you may see prompts from your firewall software 
indicating that the Sonos application is attempting to perform certain operations. 
You should always allow full access to the Sonos app for Mac or PC. You may also 
need to change the settings of your firewall software to ensure that Windows file 
sharing is not blocked. For detailed instructions, please go to our Website at http:/
/faq.sonos.com/firewall.

http://faq.sonos.com/apps
www.sonos.com/install
http://faq.sonos.com/firewall
http://faq.sonos.com/firewall
http://www.sonos.com/support
http://faq.sonos.com/specs
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enjoy your Sonos system at work, and when you get home, open your Sonos app for instant access to your 
music. The Sonos app for Mac or PC supports up to 100 households.

• Double-click the Sonos  icon, and then click Add Another Sonos System.

Wireless Setup
If you currently have a Sonos product wired to your router and you’d like to switch to wireless setup, follow the 
steps below. Switching to wireless setup may be desirable if you currently have a player connected to your 
router and you’d like to move it to another room. If you have a BRIDGE or BOOST connected to your router, 
we recommend leaving it connected.

DO NOT DISCONNECT the Sonos product that is currently connected to your router until you complete 
the wireless setup steps below.

1. Choose one of the following options:
• Using the Sonos app for PC: Select Settings -> Advanced from the Manage menu. On the General tab, 

select Wireless Setup.
• Using the Sonos app for Mac: Select Preferences -> Advanced from the Sonos menu. On the General 

tab, select Wireless Setup.
Sonos will detect your wireless network. 

2. Enter the password for your wireless network.
3. Once the password has been accepted, you can remove the Sonos product from the router and move it to 

a new location.

System Registration
Registering your music system allows you to receive technical support, Sonos software upgrades, and several 
free music service trials. At no time is any of your information provided to other companies.

Select Sonos System Registration from the Help menu.

Note: You can remove a household from your Sonos app by selecting Settings -> 
Advanced from the Manage menu and then selecting Forget Current Sonos 
System.



Sonos App for PC
The Sonos app for PC software is compatible with Windows® 7 and higher operating systems. (For the latest 
system requirements and compatible audio formats, visit our website at 
http://faq.sonos.com/specs.)

Tour the Sonos app for PC

You can choose music by selecting a music source from the MUSIC pane, select a category (such as Artists, 
Albums, or Composers), and then drilling down through the selected source, or you can search for music in 
a specific source. 
Chapter 2
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Navigation

Now Playing screen 
The Now Playing pane displays information about the audio that is currently playing in the selected room, 
playback controls, and so on.

Playback Controls
You can control the music settings for the current selection using the playback controls below. The track 
position slider allows you to move quickly backward or forward through the current track by dragging the 
slider. 

MUSIC Click MUSIC to browse or select music, or access 
playlists.

Back Click  to return to the previous screen.

Info & Options Click  to display additional options, such as adding a 
track to your Sonos Favorites or viewing artist/album 
information. The information appears in the MUSIC pane.

Play / Pause Toggles between playing and pausing the current track. 

Next / Fast Forward Jumps to the start of the next track in the queue; click and 
hold down button, or click and drag progress bar to fast 
forward.

Previous / Rewind Jumps to the start of the current track, if you are more 
than 3 seconds into the track; jumps to the start of the 
previous track, if you are less than 3 seconds into the 
track.
Click and hold down the button to rewind within the 
current track. When you release the button, playback 
resumes at the new location.

Note: You can control playback by pressing the media keys on your keyboard. 
You can also use keyboard shortcuts. For a list of keyboard shortcuts, select Help 
-> Keyboard Shortcuts.
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Queue Controls

Volume Control

• Click and drag the volume control to the right to increase the volume, or to the left to decrease the 
volume. If rooms are grouped, adjust the volume across the group using the volume slide at the top, or 
adjust the volume in one room using the individual slide. When headphones are plugged in, a headphone 
icon is visible in the volume display. If you don’t hear sound coming from your PLAY:5®, check to make 
sure there are no headphones plugged into the unit. If you adjust group volume, the volume for the 
component with headphones attached will be unaffected.

Repeat Repeats tracks in the music queue.
• Select to repeat all of the tracks in the music queue. 
• Select again to repeat the track that is currently 

playing. 
• The indicator is blue when the control is activated.

Shuffle Changes the order of the tracks in the music queue. 
• Turn shuffle off to return the tracks to their original 

playback order.
• Turn shuffle on again and get a different mix.
• The indicator is blue when the control is activated. 

Crossfade Fades out the current track while fading in the next track 
to create a smooth transition between tracks.
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• Mute temporarily silences the music in a room (for a group, all rooms in the group are affected). From the 
ROOMS pane, click to highlight the room or group you want to mute, and then click the Mute button. To 
mute one room in a group, click the volume slide and then click the Mute button for the room. To unmute, 
click the Mute button again. 

Clock and Alarms
Setting date and time
1. From the Manage menu, select Settings -> Date and Time.
2. Select your time zone, date format, and time format.
3. Select the Adjust for Daylight Savings Time checkbox, as needed.
4. Choose one of the following options:

• To set the date and time from the Internet, select the Set the date and time from the Internet checkbox. 
Sonos will periodically update the date and time from the Internet. 

• Or, set the date and time manually (Set the date and time from the Internet must be off for this option 
to be available). 

Adding an alarm
1. Click Alarms, and then click Add.
2. Choose the desired settings for this alarm, including the alarm time, the room you would like the alarm to 

play in, the music source you’d like to play from, the frequency of the alarm, and the volume and duration.
• If you check Include grouped rooms, the alarm will play in the rooms that are grouped together at the 

time the alarm goes off. It does not play in the rooms that were grouped when the alarm was originally 
added to Sonos.

• If you check Shuffle music, the play mode for the selected alarm music will be set to shuffle.
3. Click OK.
4. Select the ON checkbox for the alarm you want to turn on.

Setting an alarm
• Click Alarms, and then select the ON checkbox for the alarm you want to turn on.

Note: A headphone indicator  appears on the Volume screen when 
headphones are plugged in to a PLAY:5. If you adjust group volume, the volume 
for the PLAY:5 with headphones attached is unaffected.

Note: If the music you’ve selected is not available when the alarm goes off (such 
as an Internet radio station that has dropped off), your alarm plays the Sonos 
chime instead.

Note: You can also turn on an alarm when adding or editing it.
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Changing an alarm
1. Click Alarms, select an alarm from the list, and then click Edit.
2. Make the desired changes.

• If you check Include grouped rooms, the alarm will play in the rooms that are grouped together at the 
time the alarm goes off. It does not play in the rooms that were grouped when the alarm was originally 
added to Sonos.

• If you check Shuffle music, the play mode for the selected alarm music will be set to shuffle.
3. Click OK.

Deleting an alarm
1. Click Alarms.
2. Select the alarm you wish to delete, and then click Remove.

Setting a sleep timer
1. Click Sleep Timer.
2. Select the desired time frame.
3. If you wish to turn the sleep timer off, select Off from the list.
When a sleep timer is active, the time displays next to Sleep Timer.

Turning off an alarm

When the alarm goes off, click  to turn it off.

Software Updates
Sonos provides software updates for your music system in order to improve performance and add features. 
Sonos must be registered to receive updates. If you have not yet registered, go to 
http://faq.sonos.com/register for help with this step.

Setting software update preferences
There are two options available: 

• Periodically check for updates. When there is a software update available, an alert will appear when you 
start the Sonos app for PC. 

• Do not check for updates.

1. From the Manage menu, select Settings -> Advanced.
2. On the General tab, select the Automatically check for updates check box if you want Sonos to check 

periodically for a newer version of the software.

http://faq.sonos.com/register
http://faq.sonos.com/register
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Downloading software updates

When there is an update available,  Update Now appears in the MUSIC pane. 

1. Click  Update Now to begin the update process. 

You can also check for software updates by selecting Check for Software Updates from the Manage menu.
2. If there are updates available, click Next to download.

• Your Sonos products will all be updated as they must carry the same software version number. This 
process may take several minutes per device, depending upon your network connection. The Sonos 
app for PC will automatically close and then re-open during the update process. 

• Software updates to the Sonos app for a mobile device must be initiated from that app, so if you have 
recently updated the Sonos app for PC, you will be prompted to update your other Sonos apps the next 
time you use them. Simply follow the on-screen prompts.

• If your software is up to date, the message “Your Sonos system is up to date. No Updates are Required.” 
will appear instead.

• One or more Sonos products may need to be updated when you purchase a new Sonos product with a 
later software version, or if you plug in a Sonos product that was not in use when you performed your 
last software update. If a product’s software version gets out of sync with the rest of your Sonos system, 
a message will display in the ROOMS pane. Click the outdated room to begin the software update 
process.

For additional information, go to http://faq.sonos.com/updateerror.

Beta Programs
Sonos lets customers try out pre-release beta software to test new features and help us improve our 
products. While you are running beta software, usage data sharing is automatically turned on. 

1. From the Manage menu, select Settings -> Advanced.
2. On the Improve Sonos tab, click Beta Program, and then follow the on-screen prompts.

Language Preference
1. From the Manage menu, select Change Language.
2. Select a new language, and then click Restart Controller.

Caution: Do not disconnect power from your Sonos product(s), or in any way 
disable Sonos while this process is running. Contact Sonos Customer Support if 
an error occurs.

http://faq.sonos.com/updateerror
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Firewall Information
The Sonos Wireless HiFi System is designed to work with most firewall software. You will be prompted during 
setup to allow access to Sonos—be sure to allow access to Sonos when prompted or Sonos will not 
operate correctly. For the latest firewall information, go to http://faq.sonos.com/firewall.

You can also contact Sonos Technical Support at www.sonos.com/support.

http://faq.sonos.com/firewall
http://www.sonos.com/support


Sonos App for Mac
The Sonos app for Mac is compatible with Macintosh OS X, version 10.9 or later. (For the latest system 
requirements and compatible audio formats, you can visit our website at http://faq.sonos.com/specs.)

For easy setup, you should install the Sonos app for Mac on every Macintosh computer in your network that 
contains music files. During the setup process, you may be asked to configure your Macintosh’s firewall for 
Sonos. Also, if your Macintosh computer does not have Windows Sharing enabled, the Sonos app for Mac 
will guide you through the process of enabling it. 

Tour the Sonos app for Mac 

You can choose music by selecting a music source from the MUSIC pane, select a category (such as Artists, 
Albums, or Composers), and then drilling down through the selected source, or you can search for music in 
a specific source. 
Chapter 3
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Navigation

Now Playing screen
The Now Playing pane displays information about the audio that is currently playing in the selected room, 
playback controls, and so on.

Playback Controls
You can control the music settings for the current selection using the playback controls below. The track 
position slider allows you to move quickly backward or forward through the current track by dragging the 
slider.

MUSIC Click MUSIC to browse or select music, or access 
playlists.

Back Click  to return to the previous screen.

 Info & Options Click  to display additional options, such as adding a 
track to your Sonos Favorites or viewing artist/album 
information. The information appears in the MUSIC pane.

Play / Pause Toggles between playing and pausing the current track. 

Next / Fast Forward Jumps to the start of the next track in the queue; click and 
hold down button, or click and drag progress bar to fast 
forward.

Previous / Rewind Jumps to the start of the current track, if you are more 
than 3 seconds into the track; jumps to the start of the 
previous track, if you are less than 3 seconds into the 
track.
Click and hold down the button to rewind within the 
current track. When you release the button, playback 
resumes at the new location.

Note: You can also control playback using the media keys on your keyboard or 
keyboard shortcuts. For a list of keyboard shortcuts, select Help -> Keyboard 
Shortcuts.
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Queue Controls

Volume Control

• Click and drag the volume control right to increase volume, or left to decrease volume. If rooms are 
grouped, adjust the volume across the group using the volume slide at the top, or adjust the volume in 
one room using the individual slides. When headphones are plugged in, a headphone icon is visible in 
the volume display. If you don’t hear sound coming from your PLAY:5, check to make sure there are no 
headphones plugged into the unit. If you adjust group volume, the volume in the room with headphones 
attached will be unaffected.

Repeat Repeats tracks in the music queue.
• Select to repeat all of the tracks in the music queue. 
• Select again to repeat the track that is currently 

playing. 
• The indicator is blue when the control is activated.

Shuffle Changes the order of the tracks in the music queue. 
• Turn shuffle off to return the tracks to their original 

playback order.
• Turn shuffle on again and get a different mix.
• The indicator is blue when the control is activated. 

Crossfade Fades out the current track while fading in the next track 
to create a smooth transition between tracks.
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• Mute temporarily silences the music in a room (for a group, all rooms in the group are affected). From the 
ROOMS pane, click to highlight the room or group you want to mute, and then click the Mute button. To 
mute one room in a group, click the volume slide and then click the Mute button for the room. To unmute, 
click the Mute button again. 

Clock and Alarms
Setting date and time
1. From the Sonos menu, select Preferences -> Date and Time.
2. Select your time zone, date format, and time format.
3. Select the Adjust for Daylight Savings Time checkbox, as needed.
4. Choose one of the following options:

• To set the date and time from the Internet, select the Set the date and time from the Internet checkbox. 
Sonos will periodically update the date and time from the Internet. 

• Or, set the date and time manually (Set the date and time from the Internet must be off for this option 
to be available). 

Adding an alarm

1. Click Alarms and then click . 
2. Choose the desired settings for this alarm, including the alarm time, the room you would like the alarm to 

play in, the music source you’d like to play from, the frequency of the alarm, and the volume and duration.
• If you check Include grouped rooms, the alarm will play in the rooms that are grouped together at the 

time the alarm goes off. It does not play in the rooms that were grouped when the alarm was originally 
added to Sonos.

• If you check Shuffle music, the play mode for the selected alarm music will be set to shuffle.
3. Click OK.

Setting an alarm
To turn on an alarm:

• Click Alarms, and then select the checkbox next to the alarm you want to turn on.

Note: A headphone indicator  appears on the Volume screen when 
headphones are plugged in to a PLAY:5. If you adjust group volume, the volume 
for the PLAY:5 with headphones attached is unaffected.

Note: If the music you’ve selected is not available when the alarm goes off (such 
as an Internet radio station that has dropped off), your alarm plays the Sonos 
chime instead.

Note: You can also turn on an alarm when adding or editing it.
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Changing an alarm
1. Click Alarms, select an alarm from the list, and then click Edit.
2. Make the desired changes.

• If you check Include grouped rooms, the alarm will play in the rooms that are grouped together at the 
time the alarm goes off. It does not play in the rooms that were grouped when the alarm was originally 
added to Sonos.

• If you check Shuffle music, the play mode for the selected alarm music will be set to shuffle.
3. Click OK.

Deleting an alarm
1. Click Alarms.

2. Select the alarm you wish to delete, and then click .

Setting a sleep timer
1. Click Sleep Timer.
2. Select the desired time frame.
3. If you wish to turn the sleep timer off, select Off from the list.
When a sleep timer is active, the duration displays next to Sleep Timer.

Turning off an alarm

When the alarm goes off, click  to turn it off.

Software Updates
Sonos provides software updates for your music system in order to improve performance and add features. 
Sonos must be registered to receive updates. If you have not yet registered, go to 
http://faq.sonos.com/register for help with this step. 

Setting software update preferences
There are two options available: 

• Periodically check for updates. When there is a software update available, an alert will appear when you 
start the Sonos app for Mac software. 

• Do not check for updates. 

1. From the Sonos menu, select Preferences.
2. Click Advanced.
3. On the General tab, select the Automatically check for updates checkbox if you want Sonos to check 

periodically for a newer version of the software.

Downloading software updates

When there is an update available,  Update Now appears in the MUSIC pane. 

http://faq.sonos.com/register
http://faq.sonos.com/register
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1. Click  Update Now to begin the update process. 

You can also check for software updates by selecting Check for Updates from the Sonos menu.
2. If there are updates available, click Next to download.

• Your Sonos products will all be updated as they must carry the same software version number. This 
process may take several minutes per device, depending upon your network connection. The Sonos 
app for Mac will automatically close and then re-open during the update process.

• Software updates to the Sonos app on a mobile device must be initiated from the app, so if you have 
recently updated the Sonos app for Mac, you will be prompted to update your other Sonos apps the next 
time you use them. Simply follow the on-screen prompts.

• If your software is up to date, the message “Your Sonos system is up to date. No Updates are Required.” 
will appear instead.

• One or more Sonos products may need to be updated when you purchase a new Sonos product with a 
later software version, or if you plug in a Sonos product that was not in use when you performed your 
last software update. If a product’s software version gets out of sync with the rest of your Sonos system, 
a message will display in the ROOMS pane. Click the outdated room to begin the software update 
process.

For additional information, go to http://faq.sonos.com/updateerror.

Beta Programs
Sonos lets customers try out pre-release beta software to test new features and help us improve our 
products. While you are running beta software, usage data sharing is automatically turned on. 

1. From the Sonos menu, select Preferences -> Advanced.
2. On the Improve Sonos tab, click Beta Program, and then follow the on-screen prompts.

Uninstalling Sonos
If you wish to remove the Sonos app from your Macintosh computer, choose Uninstall from the Sonos menu, 
and then drag the application to the trash. Sonos will no longer be able to access music from this computer.

Language Preference
The Sonos app will try to use the language you have selected in your OS X® operating system (System 
Preferences).

Caution: Do not disconnect power from your Sonos product(s), or in any way 
disable Sonos while this process is running. Contact Sonos Customer Support if 
an error occurs.

http://faq.sonos.com/updateerror
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Firewall Information
The Sonos Wireless HiFi System is designed to work with most firewall software. You will be prompted during 
setup to allow access to Sonos—be sure to allow access to Sonos when prompted or Sonos will not operate 
correctly. For the latest firewall information, go to http://faq.sonos.com/firewall.

You can also contact Sonos Technical Support at www.sonos.com/support.

Enabling Windows File Sharing
1. From the System Preferences window, select the Sharing folder.
2. Check the box next to File Sharing to turn file sharing on.
3. Click Options… and select Share files and folders using SMB (Windows).
4. Click Done.

http://www.sonos.com/support
http://faq.sonos.com/firewall


Managing Rooms
Sonos lets you enjoy music in up to 32 rooms, inside or out. You can play a different song in every room or 
play the same song in every room. Group the kitchen and patio together when you’re barbecuing; group the 
rooms throughout your home in perfect synchronization for a party; or leave all your rooms ungrouped so that 
everyone can make a different music choice.

Use the ROOMS list to: 

• Select a room to play music in
• See what’s playing in every room
• Group rooms together to play the same music in synchrony
• Remove a room from a room group

Grouping Rooms
Any number of rooms can be grouped together to play the same audio in synchrony. 

• You can group or ungroup rooms while music is playing. 
• You can group all the Sonos players in your house with one touch by choosing Select All. 
• You can group rooms first and then select the music you want to play, or you can add room(s) to a 

location where music is already playing. Any rooms you group will automatically drop their current music 
queue and begin to play the music from the selected room. 

• If you want to be able to play a music queue later, save the queue as a Sonos playlist before you group 
the rooms. See Sonos Playlists for more information.
Chapter 4
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1. From the ROOMS pane, click Group to the right of the room you want to group with other rooms.

2. Check the rooms you want to add to this group, and then click Done. 
If you want to group all the rooms in your house, click Select All. All of your Sonos products will play the 
same music in synchrony until you remove rooms from the group. 

Ungrouping Rooms
1. From the ROOMS pane, click Group to the right of the group you want to change. 
2. Uncheck the room(s) you want to remove from the group, and then click Done.

Customizing Sonos For Your Room
Equalization settings
Sonos products ship with the equalization settings preset in order to provide the optimal playback experience. 
If desired, you can change the sound settings (bass, treble, balance, or loudness) to suit your personal 
preferences.

Note: If more than one room is already playing music, you will be asked to pick the 
music you want to play.

Note: The loudness setting is designed to compensate for normal changes in the 
ear's sensitivity at low volumes—you can turn this setting on to boost certain 
frequencies, including bass, at low volume.
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Select a room from the ROOMS pane, and then click . 

Renaming a room

You may want to rename a speaker when you move it to a different room.

1. Choose one of the following:
• Using the Sonos app for PC, select Manage -> Settings.
• Using the Sonos app for Mac, select Sonos -> Preferences -> Room Settings. 

2. Select the room you wish to change from the Room Settings for drop-down list.
3. On the Basic tab, do one of the following:

• Select a new name from the Room Name drop-down list.
• Type a custom name in the Room Name box, and then click  (PC) or press Enter (Mac) to apply it.

You can delete a custom room name before applying it by clicking  (PC).
After you apply the new room name, it appears in the Room Settings for list.

Turning off the status indicator light
A constant white light displays near the volume controls to indicate that the unit is functioning normally. You 
can turn it off so that there is no light when the speaker is in normal operation. If this light begins to flash 
orange, go to http://faq.sonos.com/led for additional information.

1. Choose one of the following:
• Using the Sonos app for PC, select Manage -> Settings.
• Using the Sonos app for Mac, select Sonos -> Preferences -> Room Settings. 

2. Select the room you wish to change from the Room Settings for drop-down list.
3. On the Basic tab, uncheck the White Status Light On box.

Note: Balance is only adjustable on a PLAY:1 when it is used in a stereo pair.

http://faq.sonos.com/led


Music Sources
Available Music Sources

• Radio (Internet radio stations, radio shows, or podcasts)
• Music services
• iTunes music from an iPhone, iPad, or iPod touch that’s on the same network as your Sonos products
• Audio from an Android device that’s on the same network as your Sonos products
• Google Play Music (Android devices)
• Local music library (shared folders on your home network)
• Sonos Favorites
• Sonos playlists (music queues you have saved for future playback)
• Line-in (connect an external audio source like an Apple® AirPlay® device, CD player, TV, MP3 player or 

more to a Sonos product via line-in and stream the audio to any or all Sonos products around your house) 
• Windows Media Player

What is radio?
Sonos includes a radio guide that provides immediate access to thousands of free Internet radio stations and 
broadcast programs. You can easily find Internet radio stations from all over the world—music, news, and 
variety programming, including archived shows and podcasts. You can also add your own favorite stations if 
they use streaming MP3, HLS/AAC, or WMA formats (not every radio station provides streams).

What is a music service?
A music service is an online music store or online service that sells audio on a per-song, per audiobook, or 
subscription basis. Sonos is compatible with several music services - you can visit our website at 
www.sonos.com/music for the latest list. 

What is wireless iTunes playback from iOS devices?
Wireless iTunes playback allows you to select and play music and podcasts stored on any iPad, iPhone, or 
iPod touch that’s on the same network as your Sonos products. Once you make an audio selection from your 
iPad, iPhone, or iPod touch, you can use any Sonos app to control playback. Playback is perfectly 
synchronized, in any or every room of your home. For more information, see the Sonos App for iOS Product 
Guide.

What is wireless playback from Android devices?
Wireless playback from Android devices allows you to select and play music and podcasts stored on any 
Android device that’s on the same network as your Sonos products. Once you make an audio selection from 
your Android device, you can use any Sonos app to control playback. Playback is perfectly synchronized, in 
any or every room of your home. 
Chapter 5
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What is Google Play Music service on Sonos?
You can play music to Sonos directly from the Google Play Music app on any Android device.

What is your local music library?
Your local music library includes digital music located anywhere on your home network, such as: 

• shared folders on your computer
• shared folders on another computer in your network
• Network-Attached Storage (NAS) devices

You can browse your music library in various ways. You can enter search criteria to quickly find a particular 
music selection, or you can browse through a category hierarchy to make music selections. 

Your selection choices include:

• Artists
• Albums
• Composers
• Genres
• Songs
• Imported playlists
• Folders
• Search

What is Sonos Favorites?
Sonos Favorites gives you quick and easy access to the music you love the most. You can add audio 
selections to your Sonos Favorites from any controller. Once you’ve added a favorite, it appears under Sonos 
Favorites on the Menu.

What is a Sonos playlist?
A Sonos playlist is a music queue you create and then save for future listening. For example, you might want 
to create a jazz playlist, a party playlist, or an easy listening playlist. 

What is Line-in?
You can connect an external source like a CD player, portable music player, television, or AirPlay device to 
Sonos, and stream the audio to any or all Sonos products (PLAY:5, CONNECT™, or CONECT:AMP™) around 
your house. For information on connecting an external source, please see the Sonos® System Setup Guide.

What is Windows Media Player?
If you have Windows Media Player on your computer, you will need to turn on media sharing in Windows 
Media Player so that Sonos can access the music stored in your WMP library. When media sharing is turned 
on, Sonos can play all the music in your WMP library, including any DRM-free songs you’ve downloaded from 
a music service. 

Note: If a computer on your network is turned off or is in standby mode, the music 
folders on that computer will be unavailable to Sonos until the computer is turned 
back on. 
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Radio
Sonos includes a radio guide that provides access to thousands of free Internet radio stations and broadcast 
programs. You can easily find radio from all over the world—music, news, and variety programming, including 
archived shows and podcasts. 

• If you have a music service enabled on your computer, you can additionally select Internet radio stations 
from your music service. 

• Sonos currently supports MP3, HLS/AAC, and WMA streaming audio formats.
• If you can’t find your favorite radio station or show, go to http://faq.sonos.com/radio for additional 

information.

Selecting a local radio location 
Selecting a local radio location will give you easy access to local radio stations in that city. There are two ways 
you can set your location:

• by entering a ZIP code (U.S. only)
• by selecting a city

1. From the MUSIC pane, select Radio.
2. Select Local Radio, and then click Change Location.
3. Choose one of the following:

• Enter ZIP Code, and then type a ZIP code.

• Pick a City, and then browse to find a location.

Adding a radio station 
You can use the Sonos app for Mac or PC to add a radio station that does not appear in the radio guide. You 
must know the streaming URL, and the station must use the streaming MP3, HLS/AAC, or WMA broadcast 
format. This station will be added to your Favorites list. 

1. From the Manage menu, select Add Radio Station.
2. Type the streaming URL for the radio station you want to add to your station list (for example: 

http://shoutcast.com/sbin/shoutcast-playlists.pls?rn=8107&file=filename.pls). 
3. Type the radio station’s name in the Station Name field, and then click OK.

The new radio station appears in your My Radio Stations list.

Editing a radio station 
Use the Sonos app for Mac or PC to edit a radio station.

1. From the MUSIC pane, select Radio. 
2. Browse to find the station you want to edit.

3. Click  next to the radio station you want to edit, and then choose Edit Radio Station
4. Change the streaming URL or the station name, and then click OK.

Note: You can only edit the streaming URL or station name for those radio 
stations you manually added to your My Radio Stations list. 

http://faq.sonos.com/radio
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Adding a station or show to My Radio 
When you add a radio station to My Radio Stations (or a show to My Radio Shows), it is duplicated, not 
removed, from the original radio list. 

1. From the MUSIC pane, select Radio. 
2. Find the station or show you want to add to your list.

3. Click  next to the radio station or show, and then choose Info & Options. 
4. Click Add to My Radio Stations or Add to My Radio Shows.

You can also add a station or show while listening to it by clicking , and then clicking Add to My Radio 
Stations or Add to My Radio Shows. 

Removing a station or show from My Radio
1. From the MUSIC pane, select Radio. 
2. Click My Radio Stations or My Radio Shows and find the station or show you want to remove.

3. Click  next to the selection, and then choose Info & Options. 
4. Click Remove from My Radio Stations or Remove from My Radio Shows.

Music Services
A music service is an online music store or online service that sells audio on a per-song, per audiobook, or 
subscription basis. Sonos is compatible with several music services—to view the latest list, visit our website at 
www.sonos.com/music. 

You can associate up to 32 music service accounts with your Sonos system. Each Sonos app can have a 
unique music service account associated with it so that everyone gets their own custom music experience. 
For example, you can use your Pandora account (with your radio stations and preferences) and your son can 
use his Pandora account (with his radio stations and preferences). 

When you add a music service account to a Sonos app, it becomes the default account for that controller. 
You can switch between accounts by changing the default account for a controller at any time. See Changing 
the default music service account for more information. Pandora features, such as the ability to like tracks, 
are only available on the controller that started the playback so if you start playing a Pandora station on your 
controller, you are the only one who can like tracks. For all other services, the options that are available 
depend on the permissions of the default music service account. For example, if the default Spotify account 
on a Sonos app is the trial version of the service, only certain options will be available.  

• Some music services may not be available in your country. Please check the music service’s website for 
more information.

• To activate any of the free music service trials that are included with Sonos, your Sonos system must be 
registered. 

• The Menu displays the music services that are set up to work with Sonos.
• To add or update a music service, click Add Music Services from the Menu.

Note: You can build playlists from multiple music service accounts, but you will 
not have the ability to see which account the tracks came from.

http://www.sonos.com/music
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Activating a music trial
Free music service trials are available in some countries. (Please check the individual music service’s website 
for more information.) If there is a music service trial available on your controller, simply follow the steps below 
to activate it. After the trial period is up, you will need to subscribe to the music service to keep the music 
playing.

1. From the Manage menu, select Service Settings.
The music services that are currently configured to work with your Sonos system are displayed. 

2. Click Add (PC) or  (Mac).
3. Select the music trial you would like to activate, and then click Next. 
4. Specify that you are new to the service, and then click Next.
5. Click the link to go to the website for the music service and set up an account there.
6. After you have set up a music service account, click Next

You will be asked to provide a name for your account. If there are multiple accounts for this music service 
associated with your Sonos system, the name appears below the music service name on the Menu so you 
always know which account you are using. You can change the account name or switch to a different 
account at any time. See Changing the music service account name and Changing the default music 
service account for more information.

After the trial expires
If you want to subscribe to a music service after your free trial expires, go to the music service’s website to 
sign up. Once you become a subscriber, simply update Sonos with your membership information (steps 
below) and you’ll have instant access to the music service from your Sonos system.

1. From the Manage menu, select Service Settings.
2. Choose one of the following:

• Using the Sonos app for PC, select the music service you wish to subscribe to, and click Subscribe.
• Using the Sonos app for Mac, click Subscribe next to the service you wish to subscribe to.

3. Click the link to go to the website for the music service and set up an account there.
4. After you have subscribed to the music service, click Next.
5. Enter your music service login and password, and click Next.

After your login and password have been verified by the music service, you can select your music service 
in the MUSIC pane, and make a music selection.

Adding a compatible music service account
If you are currently subscribed to a music service, simply add your music service login and password 
information to Sonos and you’ll have instant access to the music service from your Sonos system. To see the 
latest list of compatible music services, go to www.sonos.com/music.

If you have not yet subscribed to a music service, first go to the music service’s website to sign up. Once you 
become a subscriber, simply follow the steps below to add your account information to Sonos. 

Note: If your music service does not appear in the MUSIC pane, your firewall may 
be preventing Sonos from accessing it. For additional information, go to 
http://faq.sonos.com/firewall.

http://www.sonos.com/music
http://faq.sonos.com/firewall
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1. From the Manage menu, select Service Settings.
The music services that are currently configured to work with your Sonos system are displayed. 

2. Click Add (PC) or  (Mac).
3. Select the Sonos-compatible music service you would like to add, and then click Next.
4. Select I already have an account, and then click Next.
5. Enter your music service login and password, and click Next. 

You will be asked to provide a name for your account. If there are multiple accounts associated with your 
Sonos system, the name displays so you always know which account you are using. 
As soon as your credentials have been verified, the music service appears on the Menu.

Changing your music service password
If you want to change the password for a music service you subscribe to, such as Spotify or SiriusXM, you 
must first change the password with your music service provider by going to their website and changing 
your password in the account settings. Once you've changed your password there, update your Sonos 
system:

1. Go to your music service provider’s website, and change your password in the account settings. 
After you've changed your password there, follow the steps below to update your Sonos system.

2. From the Manage menu, select Service Settings.
3. Highlight the music service you wish to update.
4. Choose one of the following:

• On a PC, click Edit.
• On a Mac, click , and then select Change Password.

Changing the music service account name
The account name appears below the music service name in the Menu.

1. From the Manage menu, select Service Settings.
2. Highlight the music service account you wish to update.
3. Choose one of the following:

• On a PC, click Edit.
• On a Mac, click , and then select Change Name.

Note: If you’re a Spotify user, you can choose to log in with your Spotify account 
information or your Facebook credentials.

Note: If your music service does not appear in the MUSIC pane, your firewall may 
be preventing Sonos from accessing it. For additional information, go to 
http://faq.sonos.com/firewall.

Note: If you don’t change your password with the music service first, it won’t work 
on your Sonos system.

http://faq.sonos.com/firewall
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Changing the default music service account
You can quickly and easily change the default music service account for a controller.

1. Click  next to a music service in the MUSIC pane.
2. Select a different account.
The name for the default account appears below the music service name in the Menu. 

Replacing a music service account 
1. From the Manage menu, select Service Settings.
2. Select the music service you wish to replace.
3. Choose one of the following:

• On a PC, click Replace. 
• On a Mac, click , and then select Replace Account.

4. Enter your music service login and password, and then click Next.
After your login and password have been verified by the music service, you can select the music service 
from the MUSIC pane, and make a music selection.

Reauthorizing a music service account
Periodically, you may be asked to reauthorize account with a music service.

1. From the Manage menu, select Service Settings.
2. Select the music service that has the account you wish to reauthorize.
3. Choose one of the following:

• On a PC, click Reauthorize, and then follow the on-screen prompts. 
• On a Mac, click , select Reauthorize, and then follow the on-screen prompts.

Removing a music service account from Sonos 
You may wish to remove a music service account from your Sonos system—for example, you might want to 
remove a music service trial after it has expired.

1. From the Manage menu, select Service Settings.

2. Select the music service account you wish to remove, and click Remove (PC) or  (Mac). 

This will not delete your account from the music service—your account status with the music service will be 
unaffected.

Removing a music service trial
When a music service trial expires, you may wish to remove the expired trial from your Sonos system.

1. From the Manage menu, select Service Settings.

Caution: Any changes you make, such as liking tracks, affect the preferences for 
the default music service account.

Note: All controllers that used this account as the default account now use the 
oldest account associated with your Sonos system as the default account.
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2. Select the trial music service you wish to remove.

3. Click Remove (PC) or  (Mac), and then follow the on-screen prompts. 

Sonos Labs
Be among the first to try out a new music service before it is officially released! When you see a music service 
listed in Sonos Labs, you can go to that music service’s website, create an account, and then add your 
account information to Sonos. 

Sonos continually updates the list of available beta music services, so please check back frequently.

1. From the Manage menu, select Service Settings.
2. Click Sonos Labs (PC) or Visit Sonos Labs (Mac).
3. Select the service you would like to add, and then click Next.

You will be asked if you want to share usage data, if you have not done so already.
4. Select I already have an account, and then click Next.
5. Enter your music service login and password, and then click Next.

After your login and password have been verified by the music service, you can select the music service 
from the MUSIC pane, and make a music selection.

Wireless iTunes Playback from iOS Devices
You can select and play music and podcasts stored on any iPad, iPhone, or iPod touch that’s on the same 
network as your Sonos products. Playback is perfectly synchronized, in any or every room of your home. 
Simply choose On this iPad, On this iPhone, or On this iPod touch from the Sonos app on your iOS device 
to make audio selections and then you can use any Sonos app to control playback.

Wireless Playback from Android Devices
You can select and play music stored on any Android device that’s on the same network as your Sonos 
products. Playback is perfectly synchronized, in any or every room of your home. Simply choose On this 
Mobile Device from the Sonos app on your Android smartphone or tablet to make audio selections and then 
you can use any Sonos app to control playback.

Google Play Music (Android Devices)
You can play music to Sonos directly from the Google Play Music app on any Android device. This feature is 
available for both Standard and All Access Google Play Music customers. 

Note: All controllers that used this account as the default account now use the 
oldest account associated with your Sonos system as the default account.

Note: If your music service does not appear in the MUSIC pane, your firewall may 
be preventing Sonos from accessing it. For additional information, go to
http://faq.sonos.com/firewall.

http://faq.sonos.com/firewall
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To play music directly from the Google Play Music app to Sonos , you must have both the Google Play Music 
app and the Sonos app installed on your mobile device. 

Simply open the Google Play Music app and connect to a Sonos room or room group to start the music. 

Managing Your Local Music Library
Sonos can play music from any computer or Network-Attached Storage (NAS) device on your home network 
where you have shared music folders. During the setup process, you are guided through the process of 
accessing your local music library (such as your iTunes library). Over time, you may wish to add or remove 
music folders from this list.

Once you’ve set up your local music library, you can play selections from it by choosing Music Library from 
the Menu.

Adding a shared folder
To make another shared folder available to Sonos:

1. From the Manage menu, select Music Library Settings.
The shared music folders that are currently available to Sonos appear. 

2. Select the Folders tab and click Add (PC) or  (Mac).
3. Choose one of the following options:

• In my Music folder, and then click Next. Follow the on-screen instructions to make your music 
accessible to Sonos. If necessary, you will be guided through the steps for sharing the music folder and 
adjusting your computer’s sleep settings. 

• In another location on my computer, or on an external drive connected to my computer, and then 
click Next. Type the path or browse to the location where your music is stored and follow the on-screen 
instructions to make your music accessible to Sonos. If necessary, you will be guided through the steps 
for sharing the music folder and adjusting your computer’s sleep settings.

• On a networked device such as a network attached storage (NAS) drive, and then click Next.
a. Type the network path for the music folder (\\Name\Sharename, where Name is the network name for 

your computer or NAS device, and Sharename is the name of the top level shared folder), or click 
Browse (PC) to navigate to it. Click Next.

b. If it is not shared anonymously, enter the user name and password of a user with permission to access 
this folder, and then click Next.

Windows Sharing on a Mac 
Depending upon where your music is stored, you may be asked to provide an administrator name and 
password to allow access to your music folders. 

If your Macintosh computer does not have Windows Sharing enabled, the Sonos app for Mac or PC will guide 
you through the process of enabling it. Your music files are never copied from their current locations - your 
folders are simply shared so they can be accessed by Sonos.

Note: If you have uncompressed WAV or AIFF files in your music collection, they 
may only be available for browsing and/or selection via Songs or Folders as 
uncompressed files may not contain detailed information such as artist, title and 
genre.
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Viewing shared folders
• From the Manage menu, select Music Library Settings.

The shared music folders that are currently accessible to Sonos are displayed. (If a computer on your network 
is turned off or is in sleep or standby mode, the music on that computer will be unavailable to Sonos until the 
computer is turned back on.)

Stop accessing a shared folder
1. From the Manage menu, select Music Library Settings.
2. Click the Folders tab.

3. Select the shared folder you want to remove from the list, and then click Remove (PC) or  (Mac). 
4. Confirm that you want to delete the shared folder.

Updating the music index 
Sonos indexes your local music library so you can view your music collection by categories (such as artists, 
albums, composers, genres, or tracks.) During setup, all of your available music folders are indexed for easy 
selection. If you add new music, simply update your music index to add this music to your local music library. 

1. From the Manage menu, select Update Music Library Now.
2. Click Yes to confirm.

The message, “Indexing” appears in the MUSIC pane. When the update is complete, the message 
disappears. 

Scheduling automatic updates 
You can set your music system to automatically update your music index at the same time each day. 

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab.
3. Check the Update content every day at box, and then select the time of day you would like your music 

index to automatically update.

Contributing artists
Contributing Artists are those who appear on individual tracks within an album, including those on a 
compilation or soundtrack album. You can set your preferences to show or hide these individual artists within 
a Contributing Artists view.

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab.
3. Check or uncheck the Show Contributing Artists checkbox. 

If this box is not checked, the Contributing Artists view will not display.
The Show Contributing Artists preference setting you select applies only to this Sonos app for Mac or PC. If 
you have another Sonos app, you can select a different Contributing Artist view for it. 



Sonos App for Mac/PC 5-11
Imported playlists (M3U, WPL and PLS support)
Sonos is compatible with iTunes playlists as well as M3U, WPL and PLS playlist files created with third-party 
software (for example, iTunes, WinAmp, Windows Media Player, and so on). Sonos does not change music or 
playlist files created by other applications; these files are always treated as “read-only.”

To play music from imported playlists, drop the playlist file .PLS, .M3U or .WPL into the same music folder you 
have shared to Sonos , update your music index, and the custom playlists will appear when you select 
Imported Playlists from the Music Library menu.

iTunes support
You can view your iTunes playlists in Sonos by selecting Imported Playlists from the Music Library. 

When you make changes to your iTunes playlist(s), exit iTunes, and then update your Sonos music index to 
see the changes (see Updating the music index for more information.)

iTunes playlists are automatically imported into the Imported Playlists menu as long as your 'iTunes Music 
Library.xml' file is shared along with your music to Sonos. For typical iTunes installations, this file is located in 
the iTunes folder.

Sonos is unable to play tracks that are protected by Apple’s proprietary Digital Rights Management (DRM) 
scheme. 

Sort folders by preference
You can set the sorting preference for music folders that are accessible from your local music library. You can 
choose to sort by:

• Song name
• Song number
• File name

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab and select your sort order preference from the drop-down Sort Folders by list.

Compilation albums
If your music collection contains compilations and soundtracks, you may want to group these songs together 
in your music library instead of viewing them by individual artist. This means that any artists that appear solely 
on compilations will not appear in your Artists list. You can choose to group compilations within Sonos by:

• iTunes compilations
• Album artist

Group using iTunes compilations
iTunes normally organizes your iTunes Music folder as [Artist]/[Album]/[Track name]. iTunes has a feature that 
allows you to group your compilations albums together. This will organize your compilations and soundtrack 
albums as [Compilations]/[Album]/[Track name]. 

Within iTunes:

1. Mark individual tracks as being part of compilations by highlighting the track and then selecting File -> 
Get Info. 

2. Check the compilation checkbox. 
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3. Select View -> Column Browser and select the Group Compilations option. This will group the tracks 
you’ve marked as compilations.

Within Sonos:

You can organize your local music library to use this iTunes compilation view.

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab and select iTunes compilations from the Group Albums using drop-down list.

The music library updates immediately when you select this option.
3. If you would like to see the individual artists displayed in a Contributing Artist view, check the Show 

Contributing Artists checkbox. 
If this box is not checked, the Contributing Artists view will not display.

The Show Contributing Artists preference setting you select applies only to this Sonos app for Mac or PC. If 
you have another Sonos app, you can select a different Contributing Artist view for it. 

Group using AlbumArtists
Windows Media Player, as well as some other players, use the Album Artist category to group compilations 
and sound track albums (the Album Artist is the person, group or composer the album would be filed under in 
a store).

You can organize your local music library to use the AlbumArtist compilation view.

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab and select Album Artists from the Group Albums using drop-down list.
3. If you would like to see the individual artists displayed in a Contributing Artist view, check the Show 

Contributing Artists checkbox. 
If this box is not checked, the Contributing Artists view will not display.

The Show Contributing Artists preference setting you select applies only to this Sonos app for Mac or PC. If 
you have another Sonos app, you can select a different Contributing Artist view for it. 

Do not group compilations
If you choose not to group compilation albums, the individual artists will display within your Artists view. 

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab and select Do not group compilations from the Group Albums using drop-

down list. 
All of the individual artists will then appear in the Artists view.

Resetting local music library permissions on a PC 
Some music services may automatically change the permissions on your music folders when you add music, 
so that Sonos can no longer access your music. If your music service does this, you can change the 
preference setting to allow Sonos to reset permissions when your music index is updated. You should not set 
this preference unless you need to, as it takes longer to update your music index when this box is checked.

1. From the Manage menu, select Music Library Settings.
2. Click the Advanced tab.
3. Check the Fix permissions on music files so that Sonos can always access them box.
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Sonos Favorites
Sonos Favorites gives you quick and easy access to the music you love the most. You can add audio 
selections to your Sonos Favorites from any controller. Once you create a Favorite, it appears under Sonos 
Favorites on the Menu.

Creating a Sonos Favorite
1. From the Menu, browse to find the selection you want to add to your Sonos Favorites. 

2. Click  to the right of the selection, and choose Add to Sonos Favorites. 

Deleting a Sonos Favorite
1. Select Sonos Favorites from the Menu.

2. Click  to the right of the selection you wish to delete, and choose Delete Favorite.

Renaming a Sonos Favorite
1. Select Sonos Favorites from the Menu.

2. Click  to the right of the selection you wish to rename, and choose Rename Favorite.

Sonos Playlists 
Sonos playlists are music queues you create and save for future listening. For example, you might want to 
create a jazz playlist, a party playlist, or an easy listening playlist. 

Creating a Sonos playlist

While browsing music, you can create a Sonos playlist or add to an existing playlist. Simply click  to the 
right of a selection and choose Add to Sonos Playlist. Click New Playlist or select an existing playlist.

Note: Audio from docked iPods, wireless playback from iOS and Android devices, 
and line-in sources cannot be added to Sonos Favorites since these music 
sources may not always be available to Sonos.

Note: To create a favorite from the selection you are currently listening to, click 
 from the NOW PLAYING pane and choose Add to Sonos Favorites.

Note: When you rename a Sonos Favorite playlist, the playlist name remains 
unchanged if you access it through the Sonos Playlists menu option.

Note: You can build playlists from multiple music service accounts, but you will 
not have the ability to see which account the tracks came from.
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You can also save a music queue as a Sonos playlist by choosing Save Queue from the QUEUE pane. 

Adding to an existing Sonos playlist

1. Select a music source from the MUSIC pane.
2. Browse to find a track or album.

3. Click  next to the track or album you want to add to an existing Sonos playlist, and then select Add to 
Sonos Playlist. 

4. Select an existing playlist name to add the selection.

Moving a track within a playlist
1. Select Sonos Playlists in the MUSIC pane.
2. Select a playlist.
3. Choose one of the following:

• To move a single track, click the track you want to move and drag it to a new location within the playlist. 
Once it is in the desired location, release the mouse button.

• To move multiple tracks, check the box to the right of each track you want to move. Click and drag the 
tracks to a new location within the playlist, and then release the mouse button.

Note: Tracks that reside on your iPhone, iPod touch, or iPad, or on your Android 
device are not included in a Sonos playlist. See Wireless iTunes Playback from 
iOS Devices and Wireless Playback from Android Devices for more information.

Note: Tracks that reside on your iPhone, iPod touch, iPad, or on your Android 
device are not included in a Sonos playlist. See Wireless iTunes Playback from 
iOS Devices or Wireless Playback from Android Devices for more information.

Note: The options that appear depend on the music source you have selected.

Note: While listening to a track, you can add it to a playlist. Simply click  from 
the NOW PLAYING pane, and then select Add Song to Sonos Playlist. While 
viewing the queue, you can save it as a playlist by choosing Save Queue.



Sonos App for Mac/PC 5-15
You can select tracks that are not next to each other in the playlist. They maintain their current order in the 
new location.

Deleting a track from a playlist
1. Select Sonos Playlists in the MUSIC pane.
2. Select a playlist.
3. Choose one of the following:

• To remove a single track, click  next to the track you want to remove from the playlist, and then select 
Remove Song.

• To remove multiple tracks, check the box to the right of each track you want to remove from the playlist, 
click  next to one of the selected tracks, and then select Remove Songs.

Deleting a Sonos playlist

1. Select Sonos Playlists in the MUSIC pane.

2. Click  next to the playlist you want to delete, and select Delete Playlist. 

Replacing the tracks in a playlist
You can replace the tracks in a playlist with the contents of the queue by choosing Save Queue, and then 
selecting an existing playlist.

Renaming a Sonos playlist
1. Select Sonos Playlists in the MUSIC pane.

Note: If you delete a playlist that is also a Sonos Favorite, see Deleting a Sonos 
Favorite to remove it from your Sonos Favorites.

Note: Tracks that reside on your iPhone, iPod touch, iPad, or on your Android 
device are not included in a Sonos playlist. See Wireless iTunes Playback from 
iOS Devices for more information.
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2. Click  next to the playlist you want to rename, and select Rename Playlist. 

Windows Media Player
If you have Windows Media Player on your computer, you will need to turn on media sharing in Windows 
Media Player so that Sonos can access the music stored in your WMP library. When media sharing is turned 
on, Sonos can play all the music in your WMP library, including any DRM-free songs you’ve downloaded from 
a music service. 

Enabling Windows media sharing
1. Start Windows Media Player.
2. Click Stream.
3. Choose one of the following options:

• Allow Internet access to home media
• Allow remote control of my player
• Automatically allow devices to play my media—you may want to choose this option so streaming will 

automatically be allowed each time you add a device to your network.
When you turn on media streaming, you can select More streaming options to see a list of your networked 
devices. You can choose to allow or block individual devices.

After you have turned on media sharing in Windows Media Player, simply adjust the settings on Sonos to 
allow the music servers to display. See Displaying music servers on Sonos for more information.

Displaying music servers on Sonos
1. Choose one of the following:

• Using the Sonos app for PC, select Manage -> Settings.
• Using the Sonos app for Mac, select Sonos -> Preferences.

2. Select Advanced.
3. On the Music Servers tab, check the Show Windows Media Servers checkbox.

Note:  If you rename a Sonos playlist that is also a Sonos Favorite, the playlist 
name remains unchanged when you access it through the Sonos Favorites menu 
option. 

Note: If you do not allow media streaming on all Sonos products, those Sonos 
products will not be able to play the music stored in your Windows Media Player 
library.



Playing Music
You can get to all your music from the Menu. Choose a music service to explore it, or use Search to find what 

you want to hear. When you find what you’re looking for, click  and choose an option.

To make multiple selections, check the box that appears to the right of each item and click  for more 
options.

Managing the Music Queue
The queue is a list of songs you’ve got queued up—when one song finishes, the next song plays. You can put 
songs in the queue from a music service or your music library.

Building a queue

Choose a song and click  for more options:
• Play Now

• Play Next 

• Add to End of Queue 

• Replace Queue
Chapter 6
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Playing a song from the queue

Double-click a song or click  next to the song and choose Play Song.

Removing songs from the queue

To remove a single song from the queue, click  next to the song. To remove multiple songs, check the box 

next to each song you want to remove and then click  .

Shuffle Changes the order of the songs in 
the music queue. 

• Turn shuffle off to return the 
songs to their original playback 
order.

• Turn shuffle on again and get a 
different mix.

• The indicator is blue when the 
control is activated. 

Repeat Repeats songs in the music queue.
• Select to repeat all of the songs 

in the music queue. 
• Select again to repeat the song 

that is currently playing. 
• The indicator is blue when the 

control is activated.

Crossfade Fades out the current song while 
fading in the next song to create a 
smooth transition between songs.
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Moving songs in the queue
To move a single song, click and drag it. To move multiple songs, check the box next to each track and then 
click and drag them.

Clearing the queue
Click Clear Queue. This clears the queue for this room.

Saving a queue as a Sonos playlist
Click Save Queue. You can listen to saved playlists anytime by choosing Sonos Playlists from the Menu.  

Note: Songs that live on mobile devices can’t be saved to a Sonos playlist.
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Mini Controller
You can control Sonos playback and volume even when the Sonos app is minimized. Just click the album art 
from the NOW PLAYING pane to open a mini controller.

Turning Off Sonos
Sonos is designed to be always on; the system uses minimal electricity whenever it is not playing music. 

• To stop the music in one room or room group, just press Play/Pause in the app or on the speaker. 
• To quickly stop the music in every room, choose Pause All from the ROOMS pane.



Need More Help?
• Visit our Frequently Asked Questions (FAQ) pages at www.sonos.com/support.
• Ask us a question at http://www.sonos.com/emailsupport.

Send feedback
We’d love to hear from you! Send us feedback on our guides at: docfeedback@sonos.com

http://www.sonos.com/emailsupport
mailto:docfeedback@sonos.com
http://www.sonos.com/support
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